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Third-Party Software Legal Notices

The Apache Software License, Version 1.1
Copyright (c) 2000 The Apache Software Foundation. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation 
and/or other materials provided with the distribution.

3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment: "This product includes software 
developed by the Apache Software Foundation (http://www.apache.org/)."

Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party acknowledgments normally appear.

4. The names "Apache" and "Apache Software Foundation" must not be used to endorse or promote products derived from this software without prior 
written permission. For written permission, please contact apache@apache.org.

5. Products derived from this software may not be called "Apache", nor may "Apache" appear in their name, without prior written permission of the 
Apache Software Foundation.

THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 
EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE.

Autonomy
Copyright ©1996-2000 Autonomy, Inc.

Bouncy Castle
License Copyright (c) 2000 - 2004 The Legion Of The Bouncy Castle (http://www.bouncycastle.org)

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to 
deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell 
copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT 
LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN 
NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, 
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE 
SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Castor Library
The original license is found at http://www.castor.org/license.html

The code of this project is released under a BSD-like license [license.txt]:

Copyright 1999-2004 (C) Intalio Inc., and others. All Rights Reserved.

Redistribution and use of this software and associated documentation ("Software"), with or without modification, are permitted provided that the 
following conditions are met:

1. Redistributions of source code must retain copyright statements and notices. Redistributions must also contain a copy of this document.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation 
and/or other materials provided with the distribution.

3. The name "ExoLab" must not be used to endorse or promote products derived from this Software without prior written permission of Intalio Inc. 
For written permission, please contact info@exolab.org.

4. Products derived from this Software may not be called "Castor" nor may "Castor" appear in their names without prior written permission of Intalio 
Inc. Exolab, Castor and Intalio are trademarks of Intalio Inc.



5. Due credit should be given to the ExoLab? Project (http://www.exolab.org/).

THIS SOFTWARE IS PROVIDED BY INTALIO AND CONTRIBUTORS ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL INTALIO OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE.

Indiana University Extreme! Lab Software License
Version 1.1.1

Copyright (c) 2002 Extreme! Lab, Indiana University. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation 
and/or other materials provided with the distribution.

3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment: "This product includes software 
developed by the Indiana University Extreme! Lab (http://www.extreme.indiana.edu/)."

Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party acknowledgments normally appear.

4. The names "Indiana University" and "Indiana University Extreme! Lab" must not be used to endorse or promote products derived from this software 
without prior written permission. For written permission, please contact http://www.extreme.indiana.edu/.

5. Products derived from this software may not use "Indiana University" name nor may "Indiana University" appear in their name, without prior 
written permission of the Indiana University.

THIS SOFTWARE IS PROVIDED "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 
EVENT SHALL THE AUTHORS, COPYRIGHT HOLDERS OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE.

JDOM.JAR
Copyright (C) 2000-2002 Brett McLaughlin & Jason Hunter. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions, and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and the disclaimer that follows these conditions in 
the documentation and/or other materials provided with the distribution.

3. The name "JDOM" must not be used to endorse or promote products derived from this software without prior written permission. For written 
permission, please contact license@jdom.org.

4. Products derived from this software may not be called "JDOM", nor may "JDOM" appear in their name, without prior written permission from the 
JDOM Project Management (pm@jdom.org).

In addition, we request (but do not require) that you include in the end-user documentation provided with the redistribution and/or in the software itself 
an acknowledgement equivalent to the following: "This product includes software developed by the JDOM Project (http://www.jdom.org/)."

Alternatively, the acknowledgment may be graphical using the logos available at http://www.jdom.org/images/logos.

THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 
EVENT SHALL THE JDOM AUTHORS OR THE PROJECT CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE 
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Phaos
This Software is derived in part from the SSLavaTM Toolkit, which is Copyright ©1996-1998 by Phaos Technology Corporation. All Rights 
Reserved. Customer is prohibited from accessing the functionality of the Phaos software.

W3C
W3C® SOFTWARE NOTICE AND LICENSE

This work (and included software, documentation such as READMEs, or other related items) is being provided by the copyright holders under the 
following license. By obtaining, using and/or copying this work, you (the licensee) agree that you have read, understood, and will comply with the 
following terms and conditions.

Permission to copy, modify, and distribute this software and its documentation, with or without modification, for any purpose and without fee or 



royalty is hereby granted, provided that you include the following on ALL copies of the software and documentation or portions thereof, including 
modifications:

1. The full text of this NOTICE in a location viewable to users of the redistributed or derivative work.

2. Any pre-existing intellectual property disclaimers, notices, or terms and conditions. If none exist, the W3C Software Short Notice should be 
included (hypertext is preferred, text is permitted) within the body of any redistributed or derivative code.

3. Notice of any changes or modifications to the files, including the date changes were made. (We recommend you provide URIs to the location from 
which the code is derived.)

THIS SOFTWARE AND DOCUMENTATION IS PROVIDED "AS IS," AND COPYRIGHT HOLDERS MAKE NO REPRESENTATIONS OR 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABILITY OR FITNESS 
FOR ANY PARTICULAR PURPOSE OR THAT THE USE OF THE SOFTWARE OR DOCUMENTATION WILL NOT INFRINGE ANY 
THIRD PARTY PATENTS, COPYRIGHTS, TRADEMARKS OR OTHER RIGHTS.

COPYRIGHT HOLDERS WILL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL OR CONSEQUENTIAL DAMAGES ARISING 
OUT OF ANY USE OF THE SOFTWARE OR DOCUMENTATION.

The name and trademarks of copyright holders may NOT be used in advertising or publicity pertaining to the software without specific, written prior 
permission. Title to copyright in this software and any associated documentation will at all times remain with copyright holders.
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About exteNd Director Tutorials

This chapter provides guidelines for using the exteNd Director tutorials. Please read this information 
before you begin the exercises:

Structure of tutorials

How to use the tutorials

Configuration for running exercises

How to install the Express Portal project and application

How to download accessory files

Structure of tutorials
The exteNd Director tutorials are organized into parts, each covering a different functional area:

Inside each part you will find short tutorials that consist of one or more exercises that walk you through 
key functions of the product. Each tutorial includes the following sections:

Part Description

Exploring the Express Portal Introduces you to Express Portal, a sample portal 
application and project supplied with exteNd 
Director. 

Working with the Portal Shows you how to create a container page, and 
customize page branding and navigation.

Using Accessory Portlets Introduces accessory portlets, a set of production-
quality portlets supplied with exteNd Director. 
Many of these portlets were converted from Novell 
Portal System (NPS) gadgets. 

You will learn how to create a personal page, add 
accessory portlets to the page, and customize 
portal options and portlet preferences.

Working with Pageflows and 
Forms

Shows you how to create a database pageflow and 
customize pageflow-generated forms.

Section Description

Objective Describes what you will accomplish after completing all 
exercises

Concepts Provides links to documentation that explains concepts 
related to the tutorial exercises

Exercises Provides step-by-step instructions for performing tasks to 
meet the objective stated for the tutorial
About exteNd Director Tutorials 7



How to use the tutorials
Each part is self-contained. You can run through any combination of parts in any order you wish. In most 
cases, you can run the tutorials independently within each part; any dependencies between tutorials are 
clearly stated before you begin the exercises.

Configuration for running exercises
exteNd Director tutorials require the following system configuration:

exteNd Application Server using the exteNd Server realm, installed as part of the exteNd product 
suite

MySQL, installed with the exteNd product suite

Express Portal project and application

TIP:   See “How to install the Express Portal project and application” on page 8.

Accessory files supplied for the tutorials

TIP:   See “How to download accessory files” on page 9.

How to install the Express Portal project and application
There are two ways to install Express Portal:

Where the Express Portal project is installed

The Express Portal project is added to your file system in the Projects\Express folder of your exteNd 
install directory. The Express Portal project is a WAR application packaged inside an EAR project called 
Express.

How to deploy the Express Portal project

See the section on deploying the Express Portal in the exteNd Director Portal Guide.

What to do next Suggests what to do or read after completing the tutorial by 
providing links to other exercises and documentation

Type of install What it does

Express Adds the Express Portal project to your file system

Deploys the Express Portal project to your exteNd Application Server

Launches the Express Portal application in a new browser window

Custom Adds the Express Portal project to your file system, but does NOT deploy the project 
to your server.

IMPORTANT:  Before you begin the tutorials, you must deploy the Express Portal 
project to your exteNd Application Server, as described in “How to deploy the Express 
Portal project” on page 8.

Section Description
8   exteNd Director Tutorials
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How to download accessory files
Some tutorial exercises require accessory files that you can download from a ZIP archive called 
Director52Tutorial.zip. Follow this procedure:

To download accessory files for exteNd Director tutorials:

1 Download Director52Tutorial.zip and store it in a directory of your choice.

2 Extract files as required by tutorial exercises.
About exteNd Director Tutorials 9
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I Exploring the Express Portal

Choose an exercise for a topic you want to learn about:

• Invoke and Explore the Express Portal Application
• Open and Explore the Express Portal Project
11
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Invoke and Explore the Express Portal Application

Objective
To learn the basics of using the Express Portal, a prebuilt portal application that’s installed, deployed, and 
ready to run after you install Novell exteNd Director (in typical installations).

Before you begin See About exteNd Director Tutorials.

Concepts
About the Express Portal

About portal applications

About Novell exteNd Director

Exercises
To invoke and explore the Express Portal application:

To access the Express Portal as an end user:

To access the Express Portal as an administrator:

To invoke and explore the Express Portal application:

1 Make sure that:

The Express Portal has been installed on your system and deployed to your application server.

If you need help with Express Portal installation and deployment, see the chapter 
Preparing to Install exteNd 5 in Installing Novell exteNd or the chapter About the Express 
Portal in the exteNd Director Portal Guide.

Your application server is running.

For example, to run the exteNd Application Server in Windows, you can use the Windows 
Start menu to select:

Novell exteNd 5.0>AppServer>Application Server

To run the exteNd Application Server in Linux, execute the script SilverServer in the Novell 
exteNd AppServer/bin directory. (If you’re using MySQL for your SilverMaster database, 
make sure the MySQL server is running first; if necessary, you can start it yourself by 
executing the script StartMySQL.sh in the Novell exteNd mysql directory.)

2 Start your Web browser, then go to this URL (if your server isn’t localhost, substitute the 
appropriate name):

http://localhost/ExpressPortal

The Express Portal home page displays. You haven’t yet logged in, so for now you are accessing 
the Express Portal as a guest.
Invoke and Explore the Express Portal Application 13
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The first thing to note about this typical portal page is that it presents a variety of different portlets, 
each with its own purpose and features. Let’s see how some of these portlets work.

3 In the Novell exteNd Introduction portlet, click the minimize option on the title bar:

This minimizes that portlet on the page:
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4 In the Welcome Message portlet, click the maximize option on the title bar:

This maximizes that portlet on the page:

5 Click the restore option on the Welcome Message portlet’s title bar:

This restores that portlet to its previous state on the page.

6 In the Links portlet, click one of the links listed under Favorites.

This launches a new browser window to display the corresponding Web site; when you’re done 
looking at that window, close it.

7 Look at the list of shared pages in the Page Navigation portlet:

A shared page provides content that can be shared among users and groups. So far, you’ve been 
using a shared page named exteNd Welcome. Let’s go to the other one that’s available.

8 Select Corporate Home.

This shared page includes the following three portlets:

Weather Service

Stock Quote

Shortcut
Invoke and Explore the Express Portal Application 15



In the next steps, you’ll try some of the features of these portlets.

9 In the Weather Service portlet, type Miami, FL and click Display to get the weather report for 
that location:

10 In the Stock Quote portlet, type a stock symbol and click Get Quote to see the current market 
price information for that stock:
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11 In the Shortcut portlet, click the help option on the title bar:

This displays that portlet in Help mode:

Use the Click here to return link to switch the portlet back to View mode.

12 Use the Page Navigation portlet to go back to the exteNd Welcome shared page.

The security features of the Express Portal limit what you can see and do while a guest. If you log in, 
you’ll have access to additional capabilities (depending on who you log in as). This affects which pages 
and portlets you can access, what you can do with them, and what you can personalize.

In the next exercises, you’ll try:

Logging in as a new end user
Logging in as a portal administrator (if you are authorized to do so)

To access the Express Portal as an end user:

1 On the exteNd Welcome shared page, click New User at the bottom of the Welcome Message 
portlet.

You will create a new end-user account and log in as that user.

2 Fill in the New User form as follows and click Register:

Property What to type

User ID jdoe

Password jdoe

First Name Joe
Invoke and Explore the Express Portal Application 17



When the user is created, a message displays and you are prompted to log in.

3 Fill in the Login form as follows and click Login:

When the login is successful, the default page for this user displays. It’s the exteNd Welcome 
shared page on the default container page.

4 Use the Page Navigation portlet to go to the Corporate Home shared page.

Last Name Doe

Email jdoe@somewhere.com

Property What to type

Username jdoe

Password jdoe

Property What to type
18   exteNd Director Tutorials



5 Now that you’re logged in as a user instead of just a guest, notice that additional features are 
available to you:

An Edit option in the Weather Service portlet

A Personalize link in the Page Header portlet

6 In the Weather Service portlet, click Edit (the pencil icon) on the title bar.

This changes the mode of the portlet to let you edit this portlet’s preferences:

7 Change the View Preference to Summary.

8 Change the Number of forecasts available to 3, then click the Go back to Weather button.

9 Type Atlanta, GA and click the Display button.

The Weather Service portlet displays the 3-forecast summary for that location:
Invoke and Explore the Express Portal Application 19



10 In the Page Header portlet, click the Personalize link.

The Portal Personalizer displays. You can use it to customize your portal experience, including 
creating your own personal pages.

11 Under Portal Theme, click Select another theme.
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12 Select Basic Blue:

Then click Save to return to the Portal Personalizer page.

13 Click Portal (in the top section of the Portal Personalizer page) to return to your current page and 
see how the Express Portal looks with the new theme applied:

To access the Express Portal as an administrator:

1 In the Page Header portlet, click the Logout link.

NOTE:  This exercise requires you to log in as a portal administrator or locksmith user (such as 
the user you specified during the exteNd install). If you don’t have access to such a username and 
password, skip this exercise.

2 When the Login form displays, log in as a portal administrator or locksmith user.

When the login is successful, the default page for this user displays. It’s the exteNd Welcome 
shared page on the default container page.

3 Use the Page Navigation portlet to go to the Corporate Home shared page.
Invoke and Explore the Express Portal Application 21



4 Now that you’re logged in as an administrator instead of an end user, notice that additional features 
are available to you:

A personal page named My Administration (if you’re logged in as the user you specified 
during the exteNd install)

A Portal Administration link in the Page Header portlet

5 In the Page Navigation portlet, click the My Administration link to display that personal page.

The My Administration personal page displays two portlets:

The Things to do portlet displays a todo list; you can personalize it with your own content

The Director Administration portlet displays the Director Administration Console (DAC); 
the DAC is a predefined exteNd Director Web tier application that you can use to administer the 
exteNd Director applications you are running
22   exteNd Director Tutorials



6 In the Page Header portlet, click the Portal Administration link.

The Portal Administrator displays (under the title Shared and Container Page 
Administration). You can use it to do any of the following:

Create shared pages and assign them to users and groups

Create container pages and assign them to users and groups

A container page wraps the contents (including shared and personal pages) that the portal 
displays with a particular look and feel. You’ve been using the default container page. Using a 
different container page can change your experience in the portal.

Display the Director Administration Console (DAC)

7 Close the Portal Administrator.

8 When you’re done exploring the Express Portal application, log out and close your Web browser.

What to do next
Open and explore the Express Portal project
Invoke and Explore the Express Portal Application 23
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Open and Explore the Express Portal Project

Objective
To start getting familiar with the exteNd Director project for the Express Portal, which you can later use 
to:

Learn how the Express Portal, a typical exteNd Director portal application, is built and how it 
works

Modify the Express Portal

Develop your own portal application based on the Express Portal

Before you begin See About exteNd Director Tutorials.

Concepts
About the Express Portal

About portal applications

About Novell exteNd Director

About the exteNd Director development environment

Exercises

To open and explore the Express Portal project:

1 Make sure that the Express Portal has been installed on your system.

If you need help with Express Portal installation, see the chapter Preparing to Install exteNd 
5 in Installing Novell exteNd or the chapter About the Express Portal in the exteNd Director Portal 
Guide.

2 Start the exteNd Director development environment by doing one of the following:

The exteNd Director development environment is an integrated toolset for examining, editing, 
building, and deploying exteNd Director projects.

Platform What to do

Windows 1 Go to the list of all programs on the Windows Start menu.

2 Select Novell exteNd 5.0>Director>Director Designer.

Windows, 
Linux

1 Go to the Novell exteNd tools/bin directory.

2 Run the executable file named xd.
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3 In the Navigation Pane (on the left side of the window), click the Directory tab.

This tab lets you browse your computer’s file system. You’ll use it now to see where the exteNd 
install has stored the files for the Express Portal project.

4 Expand the directory path where you installed Novell exteNd. This is typically:
C:\Program Files\Novell\exteNd5

From there, expand and select the subdirectory Projects\Express:
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5 Notice that the Projects\Express subdirectory contains:

The exteNd Director project (SPF) files for the Express Portal:

Express.spf — EAR (Enterprise archive) project in which the other Express Portal project files 
are packaged for deployment

ExpressPortal.spf — WAR (Web archive) project that defines the Express Portal

ExpressPortal-resource.spf — JAR project for the portal’s resource set

The resulting J2EE archive files for deploying the Express Portal: Express.ear and 
ExpressPortal.war

The exteNd Application Server deployment plan files for deploying the Express Portal: 
Express_DeplPlan.xml and ExpressPortal_DeplPlan.xml

Several subdirectories containing all of the supporting files for this exteNd Director portal 
application

6 Double-click the Express.spf file.

exteNd Director opens the Express EAR project and displays the Project tab of the Navigation 
Pane:

7 Use the dropdown control on the Project tab to change the view to Archive layout, then expand 
and select ExpressPortal.war.

This gives you a J2EE-oriented look at the ExpressPortal project; it shows the ExpressPortal files 
based on how they will be organized in the WAR file generated for this project:

8 Briefly explore the project’s directories to get an idea of what they contain. In particular, expand 
and select the WEB-INF directory to find the project’s:

Descriptor files (such as web.xml)

Configuration files (in the conf subdirectory)

Supporting JAR files (in the lib subdirectory)
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9 Expand WEB-INF\lib\ExpressPortal_resource.jar.

This is a JAR subproject that’s provided to store any custom artifacts you add to the application. 
Notice that it includes subdirectories for the various types of artifacts (such as forms, images, etc.):

When you create new artifacts, they go into the appropriate subdirectory of 
ExpressPortal_resource.jar, where they automatically become part of the application’s resource set 
(along with many pre-supplied files in other JARs).

10 Click the Resources tab of the Navigation Pane:
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The Resources tab enables you to explore the Express Portal files based on how they participate in 
the application’s resource set. It often provides the most convenient entry point when you need to 
examine or modify a particular aspect of an exteNd Director project.

11 At the top of the Resources tab, make sure the child tab named View: view-name is currently 
selected.

Then use the dropdown control on the tab to change the view to portal.resources.xml:

As its name indicates, this view lists files used to implement the application’s portal features.

12 In this view, expand Portal Resources, then portal-theme, then BasicBlue.

The files that implement the portal’s BasicBlue theme are listed:

13 Double-click theme.xml.

The BasicBlue theme descriptor opens in the theme descriptor editor (because this descriptor is a 
pre-supplied artifact, it is read-only). Now you can see how the BasicBlue theme is defined:
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14 Close the theme descriptor editor.

15 Try exploring other items in this view or in any of the other views.

16 When you’re done exploring the Express Portal project, select File>Exit to close the project and 
quit the exteNd Director development environment.

What to do next
Learn about accessory portlets
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II Working with the Portal

Choose an exercise for a topic you want to learn about:

• Creating a Container Page
• Customizing Page Branding
31
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Creating a Container Page

Objective
To create a container page and learn about its default portlets: Portal Page Controller, Page Navigation, 
and Page Header.

Before you begin See “About exteNd Director Tutorials”.

Audience These exercises are designed for portal administrators—users who belong to the 
PortalAdmin administrator ACL group.

Concepts
Portal administrator ACL

Portal administrator tasks

About the Portal Administration tool

Working with Container pages

Portal Page Controller portlet

Page Navigation portlet

Page Header portlet

How content is determined for portal pages

Exercises
This section provides exercises that show you how to perform the following tasks:

Starting the Portal Administration tool

Creating a container page

Viewing the layout of a container page

Adding content to a container page

Arranging content on a container page

Choosing a default shared page for a container page

Viewing a container page

Starting the Portal Administration tool

You use the Portal Administration tool to create and maintain container pages. This tool provides a GUI 
for creating pages, adding and arranging content, selecting layouts, and assigning pages to users and 
groups.
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To start the Portal Administration tool:

1 Start the exteNd Application Server where the Express Portal application has been deployed.

2 Start a browser.

3 Start the Express Portal application by entering this URL in your browser:

http://host/ExpressPortal

The default page for a guest user opens in your browser.

4 Click Login.

The Login dialog opens in your browser:
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5 Log in as a portal administrator, then click login or the Enter key.

TIP:   A portal administrator is a user who is a member of the PortalAdmin administrator ACL group. 
Check with your system administrator for the username and password to use.

The default page for portal administrators opens in your browser.

6 Start the Portal Administration tool by selecting Portal Administration.

The Portal Administration tool opens in your browser.

Now you are ready to create a container page. Leave the Portal Administration tool running and move to 
the next exercise.
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Creating a container page

Portal administrators can create and maintain container pages using the Portal Administration tool. A 
container page is a page that wraps shared and personal pages with a consistent look and feel.

To create a container page:

1 Select Maintain Container Pages in the Portal Administration tool:

The container page administration tool opens in your browser.

2 Select New Page.

A new, untitled page appears in the Container Pages list.

3 In the fields provided, enter the following information about the new container page:

Field What to specify

Page URI Enter MyContainerPage.

Page Name Enter MyContainerPage.

Default Shared Page Do not enter a default shared page.
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4 Click Update Page.

The new page and its specifications are recorded in the portal.

Now you are ready to view the default layout of your container page. Leave your new container page 
selected in the container page administration tool and move to the next exercise.

Description Enter a description of the page.

Categories Do not assign any categories to the container page.

NOTE:  If you have not created any page 
categories, you will see the message No Categories 
Defined.

Priority Enter 999 (the highest allowed value).

NOTE:  The priority setting determines which 
container page to display if there is no explicit page 
assignment for the logged in user. The page with the 
highest priority value is the page displayed.

Field What to specify
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Viewing the layout of a container page

exteNd Director provides a Portal Layouts tool for assigning layouts to portal pages. The default layout 
for container pages is the Header Nav Content layout, as described in the next procedure.

To view the layout of a container page:

1 With your container page selected in the container page administration tool, select Choose Layout.

The Portal Layouts tool opens:
38   exteNd Director Tutorials



Note that the Header Nav Content layout is selected by default. As its name suggests, this layout 
partitions the page into header, navigation, and content areas. This is the layout you will use for 
your container page.

2 Scroll through the other layouts to see what options are available, but leave the Header Nav Content 
layout selected.

3 Click Cancel to close the Portal Layouts tool and return to the container page administration tool.

You are now ready to add content to your new container page. Leave the page selected in the container 
page administration tool and move to the next exercise.

Adding content to a container page

The content of container pages—and all other types of exteNd Director portal pages—is generated by 
portlets. You add portlets to portal pages using the Content Selector tool, as described in the next 
procedure.

exteNd Director provides a set of prebuilt portlets that encapsulate business logic that you can add to your 
pages. You can also develop your own portlets in exteNd Director to generate custom content for portal 
pages, as described in Strategies for Developing Portlets.

To add content on a container page:

1 With your container page selected in the container page administration tool, select Choose 
Content:
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The Content Selector tool opens in a new browser window.

2 Look at the Available Content list.

This is a list of all portlets that have been registered in the Express Portal application. Registered 
portlets are also called portlet registrations.

3 Look at the Selected Content list.

Note that three registered portlets have been added to the container page by default:

You will learn more about these portlets in later exercises.

4 Add the Bookmark portlet to your container page by following these steps:

Portlet Description

Page Header Provides a mechanism for creating a customized 
look and feel for Web pages in an organization—
typically in the header pane of a container page

Page Navigation Provides a graphical user interface that lets users 
navigate to all container, shared, and personal 
pages that they are authorized to access—
typically in the navigation pane of a container 
page

Portal Page Controller Displays the currently selected shared page or 
personal page in the container page—typically in 
the content pane.

IMPORTANT:  Every container page must 
contain one Portal Page Controller portlet to 
designate the area for displaying the content of a 
shared or personal page. The Portal 
Administration tool automatically adds this portlet 
to each container page you create.
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4a Select Accessory Portlets from the Filter dropdown:

The complete list of accessory portlets appears in the Available Content list.

4b Select Bookmark and click Add.

The Bookmark portlet is added to the Selected Content list.

5 Click Save Contents to record your changes and dismiss the Content Selector.

Now you are ready to arrange content based on the layout of your container page. Leave the page selected 
in the container page administration tool and move to the next exercise.
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Arranging content on a container page

You use the Layout Selector to position portlets within the layout of the container page.

To arrange content on a container page:

1 With your container page selected in the container page administration tool, select Arrange 
Content:

The Layout Selector tool opens in your browser.

NOTE:  The Portal Administration tool makes its best guess as to where to place portlets within the 
Header Nav Content layout. For example, it appropriately places the Page Header portlet in the 
Header pane, Page Navigation portlet in the Nav pane, and Portal Page Controller portlet in the 
Content pane. However, you will move the Bookmark portlet to the Nav pane in the next step.
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2 In the Layout Selector tool, click the title bar of the Bookmark portlet, then click the area under the 
Page Navigation portlet. 

The Bookmark portlet should move under the Page Navigation portlet, as shown:

3 Click Save Layout to record your changes and dismiss the Layout Selector tool.

Now you are ready to choose a default shared page to display inside your new container page. Leave the 
page selected in the container page administration tool and move to the next exercise.
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Choosing a default shared page for a container page

In this exercise you will choose a default shared page to be displayed inside your container page (if no 
other shared or personal page has been selected).

To choose a default shared page for a container page:

1 In the container page administration tool, select MyContainerPage in the list of Container Pages, 
then click Pick Default under the Default Shared Page field:

The Portal Shared Page Picker opens in a separate window.

2 Select exteNd Welcome from the list of shared pages and click OK.

3 Click Update Page.

Now you are ready to view your container page. Close all browser windows and move to the next 
exercise.

Viewing a container page

There are several ways to view a container page:

From a navigation link on a portal page

By typing an URL directly in a browser

This section describes both procedures.

To view a container page from a navigation link:

In this exercise, you will view your container page from a navigation link on the default portal page for 
portal administrators. The navigation links are generated by the Page Navigation portlet. You will learn 
more about this portlet in a later exercise.
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1 Open a new browser, start the ExpressPortal application, and log in again as the same portal 
administrator.

TIP:   You can review these steps in “Starting the Portal Administration tool” on page 33.

MyContainerPage displays in your browser:

As you can see, the Portal Page Controller portlet displays the content of exteNd Welcome—the 
page you designated as the default shared page for your container page in the exercise “Choosing a 
default shared page for a container page” on page 44. This shared page contains two portlets—
Novell exteNd Introduction and Welcome Message—which generate the content you see in the 
Content pane of MyContainerPage.

To view a container page by typing an URL directly in a browser:

1 In your current browser session, enter the following URL to view MyContainerPage:

http://server/ExpressPortal/portal/cn/MyContainerPage

For example, if your server is localhost, enter:
http://localhost/ExpressPortal/portal/cn/MyContainerPage

MyContainerPage displays in your browser.

NOTE:  If you enter the URL in a new browser session, you will need to log in again as the portal 
administrator, as described in “Starting the Portal Administration tool” on page 33.

What to do next
Customize page branding

Learn about shared pages

Learn about assigning pages to users
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Customizing Page Branding

Objective
To customize page branding by modifying preferences in the Page Header portlet.

Before you begin See “About exteNd Director Tutorials”.

Audience These exercises are designed for portal administrators—that is, users who belong to the 
PortalAdmin administrator ACL group.

Concepts
Portal administrator ACL

Portal administrator tasks

About the Portal Administration tool

Working with Container pages

Page Header portlet

Working with exteNd Director projects

Resource sets

Scoped paths

Managing portlets in the Director Administration Console (DAC)

Exercises
This section provides exercises that show you how to perform the following tasks:

Adding new branding images to the Express Portal project

Modifying the preferences of the Page Header portlet

Viewing the rebranded container page

Adding new branding images to the Express Portal project

As part of the process of customizing page branding, you will configure the Page Header portlet to 
display new logo and background images on a container page. Before beginning this exercise, be sure 
you have downloaded the accessory ZIP file required for the exteNd Director tutorials, as described in the 
section on how to download accessory files.

To add an image file to the Express Portal project:

1 Open the accessory archive Director52Tutorial.zip and select the following image files:

new_logo.gif
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new_background.gif

2 Click Extract and extract the files to the images directory of the Express Portal project’s resource 
set:

exteNd suite install directory\Projects\Express\data\images

NOTE:  Even though you have just added new resources to your Express Portal application, you do 
not need to redeploy the project. This is because exteNd Director supports dynamic loading of 
resources and classes within a resource set. 

Modifying the preferences of the Page Header portlet

exteNd Director provides a Page Header portlet that you can add to a portal page to generate content for 
a header. Often the header on a Web page provides text and images that brand a site with a corporate 
identity. If you add the Page Header portlet to a container page, it will automatically wrap all other page 
content in a Web site with the branded look and feel. 

In this exercise you will use the Portal Administration tool to modify preferences of the Page Header 
portlet to customize branding on a particular container page.

NOTE:  To modify the Page Header portlet so the changes appear on all pages in your application, you 
use the Director Administration Console (DAC) to edit preferences of a registered instance of the Page 
Header portlet. See the section on administering registered portlets.

To modify the logo image in the Page Header portlet:

1 Log in to the Express Portal application as a portal administrator and start the Portal Administration 
tool.

TIP:   You can review these steps in the section on starting the Portal Administration tool.

2 In the Portal Administration tool, select Maintain Container Pages.

The container page administration tool opens in your browser.

3 Select or create a container page that contains a Page Header portlet.

TIP:   The default container page in Express Portal —DefaultContainerPage—comes with a Page 
Header portlet. You can also add a Page Header portlet to a page, as described in the tutorial on 
creating a container page.

4 Click Choose Content.

The Content Selector tool for the selected container page opens in a new browser window.

5 Select Page Header in the Selected Content list and click Content Preferences.

The Content Preferences editor opens in your browser.

6 In the Logo Image preference, change the name of the image file in the value field from 
portal_header_n.gif to new_logo.gif.

NOTE:  new_logo.gif is one of the image files you added to the Express Portal project’s resource 
set in the previous exercise.

The value of the Logo Image preference should now read:
${Portal/Url/Resource/images/new_logo.gif}

NOTE:  The syntax ${Portal/Url/Resource/images} is a scoped path that allows you to quickly 
access data in an exteNd Director application. In this example, the scoped path points to the images 
directory in the application’s resource set without requiring that you specify absolute paths.

Now you are ready to modify the background image of the Page Header portlet. Leave the Content 
Preferences editor running and move to the next exercise.
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To modify the background image of the Page Header portlet:

1 Find the Background Image preference and change the name of the image file in the value field 
from portal_header_arch_background.jpg to new_background.gif.

NOTE:  new_background.gif is one of the image files you added to the Express Portal project’s 
resource set in a previous exercise.

The value of the Background Image preference should now read:
${Portal/Url/Resource/images/new_background.gif}

2 Find the Repeat Pattern preference and select the value Repeat on x axis from the dropdown 
menu.

3 Find the Background Position preference and select the value Top Left from the dropdown menu.

Now you are ready to modify the site name of the Page Header portlet. Leave the Content Preferences 
editor running and move to the next exercise.

To modify the site name of the Page Header portlet:

1 In the Content Preferences editor, scroll down to the Site Name preference. In its value field 
change the text Novell to My Garden Supply Company.

TIP:   You may need to scroll right in the value field to find the text Novell.

2 Scroll further right in the value field and delete the following text:
exteNd&#8482; Director

3 Click Save Preferences.

The Content Preferences editor closes.

4 Click Save Contents to record your changes and dismiss the Content Selector tool.

5 Close all other Express Portal application windows.

Now you are ready to view the rebranded page. Move to the next exercise.

Viewing the rebranded container page

In these exercises you will see how your modifications to the Page Header portlet rebrand the container 
page. You will also learn about the scope of your modifications.

To test the rebranded container page:

1 Start a new application server session.

2 Open a new browser and log in to the Express Portal application.

3 Open the container page that contains the rebranded header.

TIP:   You can review how to open a container page in the section on viewing a container page.
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The rebranded header should look like this:

Note the new logo, site name, and background image in the page header.

TIP:  The modifications you made apply only to this instance of the Page Header portlet, which appears 
on this particular container page. This is because you have not changed the registered instance of the 
Page Header portlet, only the page instance. If you add the registered Page Header portlet to a new page, 
the original logo, site name, and background will appear. Try this in the next exercise. Leave your modified 
page open in the browser.

Determining the scope of your Page Header modifications:

1 With your modified page open in your browser, select Portal Administration.

2 Create a new container page with these properties:

TIP:   You can review these steps in the section on creating a container page.

3 Click Update Page to record your changes.

4 Select Choose Content.

Recall that a registered Page Header portlet is added to new container pages by default (along with 
registered Page Navigation and Page Controller portlets).

5 Choose Page Header, then select Content Preferences.

6 In the Content Preferences editor, check the preferences you changed in the previous exercise:

Logo Image

Background Image

Repeat Pattern

Background Position

Site Name

Note that these preferences are set to their original values.

Property What to specify

Page Name TestContainerPage

Priority 1
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7 Close all browser windows.

8 View the rebranded container page and TestContainerPage in a new browser session to compare the 
headers.

TIP:   You can review the steps for viewing a container page in the section on viewing a container 
page.

What to do next
Learn about accessory portlets

Learn about portlet definitions, portlet registrations, and portlet page instances

Learn about shared pages

Learn about assigning pages to users and groups
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III Using Accessory Portlets

Choose an exercise for a topic you want to learn about:

• Working with Accessory Portlets
• Using Shortcut portlets for form-based authentication
• Using IFrame portlets for content management
• Creating shortcuts with images from the resource set
53
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Working with Accessory Portlets

Objective
Add some accessory portlets to a personal page, use the portlet options, and access portlet preferences.

Before you begin See “About exteNd Director Tutorials”

Audience This section is for portal end-users.

Concepts
Working with installed portlets

About the Portal Personalizer

Working with Personal pages

Working with portal layouts

Working with portal options 

Portlet preferences

Exercises
This section provides exercises that show you how to perform the following tasks:

Adding accessory portlets to a page

Using portal options

Accessing help for accessory portlets

Accessing portlet preferences

Adding accessory portlets to a page

Accessory portlets are a set of production-quality portlets that you can use on personal or shared pages 
in the ExpressPortal project or in your own exteNd Director project. They provide rich interaction with 
web sites, access to local applications, form-based authentication, and other functions of interest to 
general users. Some of the accessory portlets have been converted from Novell Portal System (NPS) 
gadgets. All of the accessory portlets conform to the Java Portlet 1.0 specification.

To access ExpressPortal:

1 Start the exteNd Application Server where the Express Portal application has been deployed.

2 Start a browser.

3 Open the Express Portal application by typing this URL:
http://host/ExpressPortal
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NOTE:  host is the machine on which the Express Portal application is running. If the application is 
running on your local machine, use localhost.

The default page for a guest user opens in your browser:
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4 Click Login on the right side of the portal title bar.
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The login page displays:

5 If you have logged in to ExpressPortal previously you can use the same name and password to 
access the default ExpressPortal page. Otherwise, create a new user by following these steps:

5a Click the New User? link on the login page.

5b Fill in all of the requested fields. For example:

5c Click Register.

The login page reappears with a message indicating the new user has been successfully created. 

6 Log in using the new user and password.

Field Sample Entry

User ID MDoe

password mdoe

First Name Mary

Last Name Doe

Email mdoe@tutorial.com
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The default page for a non-administrator user opens in your browser.

Now you are ready to create a personal page with accessory portlets. Leave the default user page running 
in the browser and move to the next exercise.
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To create a personal page and add accessory portlets:

1 Click Personalize on the right side of the page. 

The Portal Personalizer opens in your browser:

2 Under Personal Pages select New.

3 Enter the following properties:

4 Click Update.

My Accessory Portlets is added to the Personal Pages list.

5 With the new page selected, click Choose Content.

Property What to specify

Page Name Enter My Accessory Portlets

Description Enter Tutorial
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The Content Selector opens in a new browser window:

6 From the Filter dropdown list choose Accessory Portlets.

7 From the Available Content list, select the following portlets and add them to the page by clicking 
Add:

IFrame

Rss News Feed

Shortcut

TIP:   You can select multiple items by pressing the Ctrl key while clicking, then add all items as a 
group.

8 Close the Content Selector by clicking Save Contents at the bottom of the form.

You return to the Portal Personalizer.

9 Choose Arrange Content.

The Layout Selector opens in a new browser window.

10 Move Shortcut and Rss News Feed into the right column by clicking their title bars, then clicking 
inside the right column. 
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The Layout Selector should look like this:

11 Click Save Layout at the bottom of the form.

The Layout Selector closes and you return to the Portal Personalizer.

12 In the Portal Personalizer, choose Portal.

The default ExpressPortal page opens in your browser.

Notice the new page, My Accessory Portlets, listed under Personal Pages in the navigation pane
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13 Select My Accessory Portlets.
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The new page opens in your browser, displaying the IFrame, Shortcut, and Rss News Feed portlets 
in the content frame. It should look something like this:

Now you are ready to learn about portal options. Leave this page running in your browser and move to 
the next exercise.

Using portal options

A portal option is text or an image that appears in the title bar of a portlet. Each portal option specifies 
a link that controls which action will be performed when the user clicks on the option. For example, a 
portlet title bar can provide buttons to allow users to edit, minimize, or restore the portlet. 
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To use portlet options:

1 Move your cursor to the title bar of the RSS News Feed portlet and click the minimize button, as in 
this example:

TIP:   To display a tool tip, hover over the option with your mouse.

The RSS News Feed portlet window is minimized and the minimize button is replaced with a 
restore button.

2 Click the restore button.

The Rss News Feed portlet is restored to its original size.
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3 Move your cursor to the title bar of the IFrame portlet and click the maximize button:

The IFrame portlet window is maximized to occupy the entire browser window. The maximize 
button is replaced with a restore button.

4 Click the restore button to return the IFrame portlet to its original size.

NOTE:  The IFrame portlet also has an edit option that allows you to access and modify the 
preferences defined for this portlet:
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Accessing help for accessory portlets

Each accessory portlet provides online help that can be accessed from an option in its title bar.

To access help for accessory portlets:

1 Click the help icon in the title bar of each portlet.

A general description of the portlet appears in the portlet window. 

2 Choose Click here to Return at the bottom of each help window to dismiss the help text and 
restore the original content:
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Now you are ready to learn about portlet preferences. Leave your My Accessory Portlets page running in 
your browser and move to the next exercise.

Accessing portlet preferences

Each of the accessory portlets has default content and behavior, defined and stored as preferences. You 
can customize portlets by modifying portlet preferences.

To access preferences for a portlet:

1 Click Personalize on the right side of the My Accessory Portlets page. 

The Portal Personalizer opens.

2 In the Portal Personalizer select Choose Content.

3 From the Selected Content box select IFrame and choose Content Preferences:

The Content Preferences editor opens for the IFrame portlet:

Now you are ready to access help for portlet preferences. Leave the Content Preferences editor open and 
move to the next exercise.
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To access help for portlet preferences:

1 Select Descriptions at the bottom of the Content Preferences editor.

Help for each preference appears in the Descriptions column of the editor:

2 Select Hide Descriptions.

3 Close all browser windows.

What to do next
Create a container page

Brand a container page

Create shortcuts with images from the resource set

Use Shortcut portlets for form-based authentication

Use IFrame portlets for content management
Working with Accessory Portlets 69

tutwwpCreateContainerPage.html
tutwwpCustomizePageBranding.html
tutuapShortcut.html
tutuapFormBasedAuth.html
tutuapIFrame.html


70   exteNd Director Tutorials



Using Shortcut portlets for form-based authentication

Objective
To enable form-based authentication using replacement strings in Shortcut portlets. 

A Shortcut portlet generates a list of shortcut links to Web resources and local applications. 

Replacement strings are keywords that reference values that can change dynamically at runtime, such as 
a user's login name and password.

Before you begin See “About exteNd Director Tutorials”.

Audience This section is for all users, whether or not they have administrative privileges.

Concepts
Why use form-based authentication?

Impact of the Internet Explorer security patch

Replacement strings

Working with portal pages

About the Portal Personalizer

About portlets

Portlet window

Working with installed portlets

Why use form-based authentication?

exteNd Director supports several mechanisms for authenticating users of Web applications:

Basic authentication: The Web server authenticates a user against the user name and password 
obtained from the Web client. 

Form-based authentication: The Web server provides an application-specific form for logging in 
and specifying credentials. 

There are several reasons for using form-based authentication instead of basic authentication with 
exteNd Director:

To customize the authentication user interface—for example, the login and error pages presented to 
users of your Web application through an HTTP browser

To work around the limitations imposed on basic authentication by the Microsoft Security Patch 
MS Bulletin MS04-004 Cumulative Security Update, as described in “Impact of the Internet 
Explorer security patch” on page 72.
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Impact of the Internet Explorer security patch

The Microsoft Security Patch MS Bulletin MS04-004 Cumulative Security Update impedes basic 
authentication in several Accessory portlets that ship with exteNd Director: Shortcut, IFrame, NetMail, 
Notes, and Exchange. If you install this patch, you should configure these portlets to use form-based 
authentication (instead of basic authentication) for target Web sites and destination servers that support 
form-based authentication.

NOTE:  The exteNd Application Server supports form-based authentication.

To address a potential security breach, the Microsoft patch removes support from Internet Explorer and 
Windows Explorer for the clear-text authentication syntax 
http(s)://username:password@server/resource.ext. exteNd Director uses this syntax to support 
basic authentication in its Accessory portlets by generating URLs that pass clear-text authentication 
credentials to the target Web site. If the patch has been installed, these URLs generate an invalid syntax 
error from the browser.

Exercises
The exercises in this section show you how to configure a Shortcut portlet to use form-based 
authentication when you log in to Novell Forge, a collaborative Web site for developing open-source 
projects. 

It also provides guidelines for implementing form-based authentication with other Accessory portlets.

Creating an account on Novell Forge

Adding a Shortcut portlet to a personal page

Configuring the Shortcut portlet to use form-based authentication

Using replacement strings to secure credentials in form-based authentication

Implementing form-based authentication with other Accessory portlets

Creating an account on Novell Forge

In this exercise, you will create an account on Novell Forge, a Web site that supports form-based 
authentication. Novell Forge provides the ability to create, manage, and contribute to open-source 
software development projects.

After completing the tutorial exercises, you can use your Novell Forge account to explore ways in which 
you may use site and the tools it offers.

To create an account on Novell Forge:

1 Open a browser and enter this URL:
http://forge.novell.com
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The Novell Forge home page opens in your browser. The page should look something like this:

2 Click Register with Novell Forge.
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The Novell Account form appears in your browser.

3 Fill out the profile according to the instructions on the page, then click next at the bottom of the 
page.

TIP:   Remember the user name and password that you enter. You will need these credentials for a 
later exercise.

4 Fill out the account synchronization form as appropriate and click finish at the bottom of the page.

A confirmation window should appear, indicating that you have registered successfully with Novell 
Forge.

Now you are ready to add a Shortcut portlet to a personal page. Leave your browser running and move to 
the next exercise.
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Adding a Shortcut portlet to a personal page

In this exercise you will create a personal page and add a Shortcut portlet to the page.

Creating a personal page

To create a personal page:

1 Start the exteNd Application Server where the Express Portal application has been deployed.

2 Start the Express Portal application by entering this URL in your browser:

http://host/ExpressPortal

The default page for a guest user opens in your browser.

3 Click Login.
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The Login dialog opens in your browser:

4 Log in as an authorized user, then click login or the Enter key.

TIP:   If you need to create a user, see the exercise on adding a new user.

The default page for the user you specified opens in your browser.
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5 On the default page, select Personalize.

NOTE:  This is the default page for a user who is not an administrator. Your default page will look 
different if you logged in as an administrator, but the Personalize option is still available in a similar 
location on the page.

The Portal Personalizer opens in your browser.
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6 Under Personal Pages select New.

An untitled page is added to the list of personal pages.

7 Enter the following properties for the new page:

8 Click Update.

The new page appears in the list of personal pages.

Now you are ready to add a Shortcut portlet to the new personal page. You will configure the portlet to 
use form-based authentication when logging in to the Novell Forge site. Leave the Personalizer running 
and move to the next exercise.

Adding a Shortcut portlet to a page using the Content Selector tool

In this exercise, you will use the Content Selector to add a Shortcut portlet to My Authentication Page, 
the personal page you just created.

To add a Shortcut portlet to your personal page using the Content Selector:

1 Select My Authentication Page in the Personal Pages list and click Choose Content.

The Content Selector displays in a new window.

2 From the Filter dropdown list choose Accessory Portlets.

3 From the Available Content list select Shortcut and add it to the page by clicking Add.

Property What to specify

Page Name My Authentication Page

Description Tutorial
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Now you are ready to configure the Shortcut portlet to provide form-based authentication when you log 
in to the Novell Forge Web site. Leave the Content Selector open and move to the next exercise.

Configuring the Shortcut portlet to use form-based authentication

In this section, you will perform the following exercises:

Configure the Shortcut portlet to use form-based authentication for the Novell Forge Web site, as 
described in “Configuring the Shortcut portlet for form-based authentication” on page 79.

Test the runtime behavior when you log in to the Novell Forge site, as described in “Testing form-
based authentication for Novell Forge” on page 87.

Configuring the Shortcut portlet for form-based authentication

The Shortcut portlet provides a wizard that automatically generates site-specific POST parameters. You 
will learn how to use this wizard in the following exercise.

To configure the Shortcut portlet to use form-based authentication:

1 Select the Shortcut portlet in the Selected Content list and click Content Preferences.

The Content Preferences sheet for the Shortcut portlet opens.
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TIP:   To get more information about preferences, click Descriptions at the bottom of the preference 
sheet:

2 In the Preference Value column for the shortcut link preference, click the View/Edit Custom 
Preference link.

A second preference sheet opens in your browser containing a set of predefined shortcuts, each 
with its own set of preferences. You can also add new shortcuts. 
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3 Maximize the preference sheet.

Note that a shortcut is already defined for the Novell Forge Web site:
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4 Delete all predefined shortcuts except Novell Forge by clicking their delete buttons:
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5 Display the preferences for the Novell Forge shortcut by clicking the plus sign to the left of Details:

If a popup opens, asking you to select a user name for the form, click Cancel. You will use the 
Wizard instead.
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6 Click Use Wizard for the URL preference:

A view of the home page for the Novell Forge Web site opens in the wizard.
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7 In the login area, fill in the Username and Password fields with the Novell Forge credentials you 
created in “Creating an account on Novell Forge” on page 72. Then, click User Login.

8 If an alert box appears, asking if you want Password Manager to remember your login credentials, 
respond as appropriate.

9 If a popup opens, asking you to select a user name for the form, click Cancel.
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The Shortcut preferences sheet opens in the wizard, automatically configured for form-based 
authentication. Note that Post is set to true and that several URL/Post parameters are defined for 
the Novell Forge site, including the username and password you entered in Step 7, as in this 
example:

NOTE:  Notice that your password appears in the clear in the password field. To avoid exposing 
your password on the preference sheet, you can use replacement strings, as illustrated in a later 
exercise, “Using replacement strings to secure credentials in form-based authentication” on 
page 89.

10 Click Save at the bottom of the preference sheet.

Your values are recorded and you exit the wizard.
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11 Back in the Shortcut preference sheet, click Return to List View.

12 Click Save Preferences.

The Content Preferences sheet closes, returning you to the Content Selector.

13 Click Save Contents to record your changes and dismiss the Content Selector.

14 Close the Personalizer and all other browser windows.

By default, sensitive URL/Post parameters (such as passwords) that you enter in the Shortcut Portlet 
wizard are stored as encrypted values in the exteNd Director database.

Now you are ready to test form-based authentication in your Shortcut portlet. Move to the next exercise.

Testing form-based authentication for Novell Forge

In this exercise, you will log in to the Novell Forge Web site using form-based authentication. You will 
then open a new browser session to demonstrate that parameters used in the POST to the Novell Forge 
site are persisted as portlet preferences in the portal application database, rather than in the current 
browser session.

To test form-based authentication for Novell Forge:

1 Start a new browser and log in to the Express Portal application.

TIP:   If you need to review these steps, see “Adding a Shortcut portlet to a personal page” on 
page 75.
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2 When your default portal page opens in the browser, click My Authentication Page under 
Personal Pages in the navigation area.

My Authentication Page appears in the content area of your browser, displaying your Shortcut 
portlet.
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3 Click the Novell Forge shortcut link.

A Security Alert appears, indicating you are about to be redirected to a nonsecure connection.

4 Confirm that you want to proceed.

You are automatically logged in to the Novell Forge application. When you clicked the Novell 
Forge shortcut link, the Shortcut portlet used form-based authentication to post the credentials from 
a persistent data store, the exteNd Director database.

Now you are ready to use replacement strings to secure your credentials in form-based authentication. 
Close the Novell Forge application, but leave My Authentication Page running in the portal in your 
browser.

Using replacement strings to secure credentials in form-based authentication

When you entered credentials for form-based authentication in a previous exercise, the username and 
password were exposed, or in the clear. In these exercises, you will secure the identity of your password 
by using replacement strings, then test the runtime behavior when you log in to the Novell Forge site.

Recall that replacement strings are keywords that reference values that can change dynamically at 
runtime, such as a user's login name and password.

Using replacement strings to secure credentials in form-based authentication:

1 In My Authentication Page, click Personalize.

The Portal Personalizer opens in your browser.

2 Select My Authentication Page in the Personal Pages list, then click Choose Content.

The Content Selector opens in a separate browser window.

3 Choose Novell Forge in the Selected Content list, then click Content Preferences.
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The preference sheet for your Novell Forge portlet opens in your browser.

NOTE:  The preference sheet displays a lock symbol next to details, as in this example:

This symbol indicates that preferences are stored as encrypted values.

4 Click View/Edit Custom Preference to open the preference sheet for the Novell Forge shortcut 
link.

5 Click Details to display the preferences, then maximize the browser window.

6 Copy your login credentials from the URL/Post Parameter fields to the User and Password fields 
further down on the preference sheet:

NOTE:  Filling in the User and Password fields stores the credentials permanently in the 
preference so they persist across sessions. The value you copy to the Password field is not exposed 
on the preference sheet.
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7 In the URL/Post Parameter list, substitute the following replacement strings for the values of 
username and password:

At runtime, the values you entered in Step 6 will be substituted for the associated replacement 
strings and passed as your credentials to be validated by the server. In addition, the password is 
stored as an encrypted value in the database.

8 Set Authentication Required to true.

URL/Post Parameter key Replacement string

username $PORTLET_AUTH_ID$

password $PORTLET_AUTH_PWD$
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Your preference sheet should look something like this:

9 Click Save at the bottom of the preference sheet.

10 If an alert box appears, asking if you want Password Manager to remember your login credentials, 
respond as appropriate.

Your values are recorded and you exit the wizard.
92   exteNd Director Tutorials



11 Back in the Shortcut preference sheet, click Return to List View.

12 Click Save Preferences.

The Content Preferences sheet closes, returning you to the Content Selector.

13 Click Save Contents to dismiss the Content Selector.

14 Close all other browser windows.

Now you are ready to test form-based authentication using replacement strings. Move to the next 
exercise.

To test form-based authentication using replacement strings:

1 Start a new browser and log in to the Express Portal application.

TIP:   If you need to review these steps, see “Adding a Shortcut portlet to a personal page” on 
page 75.
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2 When your default portal page opens in the browser, click My Authentication Page under 
Personal Pages in the navigation area.

My Authentication Page appears in the content area of your browser, displaying your Novell Forge 
portlet. This time, the Novell Forge shortcut link appears with a button next to it:

This symbol indicates that stored credentials exist for this shortcut link. If you click this image, you 
can modify the stored credentials associated with this shortcut link—in this case, the credentials for 
the Novell Forge site.

3 Click the Novell Forge shortcut link.

A Security Alert appears, indicating you are about to be redirected to a nonsecure connection.

4 Click Yes to proceed.

You are automatically logged in to the Novell Forge application, again demonstrating that single 
sign-on was achieved using credentials that persist across sessions.
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Implementing form-based authentication with other Accessory portlets

In the previous exercises, you learned how to configure the Shortcut portlet to use form-based 
authentication. You can also implement form-based authentication with other Accessory portlets that 
ship with exteNd Director:

Configuring IFrame, NetMail, and Exchange portlets for form-based authentication

Unlike Shortcut, the IFrame, NetMail, and Exchange portlets do not have wizards for setting site-specific 
URL/Post parameters automatically. As an alternative, you can use the Shortcut portlet wizard to define 
the key/value pairs for the target site, then copy these pairs manually to the URL/Post parameter fields in 
the IFrame, NetMail, or Exchange portlet.

Configuring Notes portlets for form-based authentication

For the Notes portlet, the URL/Post parameters are hard-coded specifically for the Lotus Notes/Domino 
server.

The Notes portlet posts to an URL of this form:

protocol + “://” + IP address + “:” + port + “/names.nsf?Login”

Here is an example:

http://weddev2:80?names.nsf?Login

The Notes portlet also provides the following parameters on the POST:

If you need more flexibility in specifying an URL and POST parameters, use the IFrame portlet instead 
of the Notes portlet for form-based authentication.

Accessory portlet Description To implement form-based authentication

IFrame Displays a given URL in an IFrame See “Configuring IFrame, NetMail, and 
Exchange portlets for form-based 
authentication” on page 95.

NetMail Provides Novell NetMail calendar 
and messaging functions

See “Configuring IFrame, NetMail, and 
Exchange portlets for form-based 
authentication” on page 95.

Exchange Provides access to Microsoft 
Exchange calendar and 
messaging functions

See “Configuring IFrame, NetMail, and 
Exchange portlets for form-based 
authentication” on page 95.

Notes Provides access to Lotus 
Notes/Domino HTTP email

See “Configuring Notes portlets for form-
based authentication” on page 95.

Parameter key Description

Username Lotus Notes user ID

Password Lotus Notes password

RedirectTo Lotus Notes URL to redirect to after a successful login
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What to do next
Browse the Novell Forge site for information about collaborative, open-source development 
projects.

Configure the IFrame, NetMail, and Notes portlets to use form-based authentication.

Learn about shared pages.

Learn about container pages.

Create a container page.

Brand a container page.

Learn how to develop a custom portlet.

Create shortcuts with images from a resource set

Create a content management page using IFrame portlets
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Using IFrame portlets for content management

Objective
To set up a content management portal page using IFrame portlets. An IFrame portlet invokes an URL 
inside an IFrame within the portlet window. An IFrame, or inline frame, gets content referenced by an 
URL and displays it in a browser subwindow—in this case, the window of the portlet on the browser 
page.

Before you begin See “About exteNd Director Tutorials”.

Audience This section is for content administrators.

Prerequisites This tutorial requires the following software:

Content Management subsystem. The exteNd Enterprise Suite comes with Content Management; 
the Professional Suite does not include this subsystem.

Internet Explorer version 5.5 or higher, a requirement for running the Content Management tool in 
the Director Administration console.

TIP:  If you want to access content management functions using portlets that run in all supported 
browsers and platforms, check out the Content Administration portlets that ship with exteNd Director.

Concepts
About the Content Management subsystem

The content repository

Content administrator

Importing and exporting content

Checking documents in and out

Publishing content

Working with portal pages

About the Portal Personalizer

Managing users and groups

Using the Directory section of the Director Administration Console (DAC)

ACL subsystem administrators

About portlets

Portlet window

Working with installed portlets
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Exercises
The exercises in this section show you how to use IFrame portlets to access several content management 
functions from a single portal page. You will also learn how to assign content administrator privileges to 
a user and import sample content.

Designating a content administrator

Importing folders and documents into the content repository

Browsing the content repository from a personal page

Creating documents from a personal page

Designating a content administrator

In this exercise, you will assign content administrator privileges to a new user. To perform these 
administrative tasks, you need to log in as a user with locksmith privileges.

Adding a new user

To add a new user:

1 Start the exteNd Application Server where the Express Portal application has been deployed.

2 Start an Internet Explorer browser (version 5.5 or higher).

3 Start the Express Portal application by entering this URL in your browser:

http://host/ExpressPortal

The default home page for a guest user opens in your browser.
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4 Click Login.
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The Login dialog opens in your browser:

5 Log in as a locksmith user, then click login or the Enter key.

TIP:   A locksmith is a user who is a member of the LocksmithElementType administrator ACL group. 
Check with your system administrator for the user name and password to use.

The default home page for administrators opens in your browser.
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6 Start the Portal Administration tool by selecting Portal Administration.

The Portal Administration tool opens in your browser.
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7 Select Director Administration Console.

The Director Administration Console (DAC) opens in your browser.

8 Click the Directory Management icon.

The Directory Management tool opens in your browser with the Users tab selected.
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9 Click Add to add a new user.

10 Enter the following information for your new user:

Field What to specify

User ID adminContent

Password and Confirm Password content
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11 Click Save to record your entries.

The new user adminContent is added to your portal application.

Now you are ready to assign content administrator privileges to the new user. Leave the Director 
Administration Console running and move to the next exercise.

Assigning security privileges to a content administrator

This exercise shows you how to assign content administrator and search administrator privileges to the 
adminContent user you just added to the Express Portal application. There are several permissions that 
provide varying levels of access to documents, folders, metadata, and other elements in the content 
repository:

In this exercise, you will grant all of these permissions to the content administrator.

Admin type Permission Level of access

ContentAdmin PROTECT Set security on content elements

ContentAdmin READ View content and metadata

ContentAdmin WRITE Create, modify, and save content elements

SearchAdmin WRITE Create, modify, and save fields in document types
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To assign security privileges to a content administrator:

1 In the Director Administration Console, click the Security Management icon.

The Security Management tool opens in your browser.

2 In the Admin type dropdown menu, select ContentAdmin.

3 Leave PROTECT selected in the Permission dropdown menu.
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4 Assign content administrator permissions to the adminContent user by following these steps:

4a In the Users available list, select exteNd Server\adminContent.

4b Click < to add the adminContent user to the selected administrator ACL group.

4c Click Save.

5 Select WRITE in the Permission dropdown menu and repeat Step 4.

6 Select READ in the Permission dropdown menu and repeat Step 4.

7 Now assign search administrator write permission to the adminContent user by following these 
steps:

7a In the Admin type dropdown menu, select SearchAdmin.

7b In the Permission dropdown menu, select WRITE.

7c Repeat Step 4.
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8 Click the Director Home icon to return to your home page:
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9 On the home page, click logout:

10 Log back in as the content administrator user you just created:

Recall that the user name is adminContent and password is content.

Now you are ready to import folders and documents into the content repository. Leave the home page 
open in your browser and move to the next exercise.

Importing folders and documents into the content repository

exteNd Director provides a repository for storing content through its Content Management (CM) 
subsystem. The content repository can store any type of content that can be digitized including:

Plain text, XML, and HTML documents

Image, sound, and executable files

Other types of binary data

In this exercise you will import sample documents and folders into the repository. This content will be 
used in subsequent exercises to test your ability to browse the repository and create new documents via 
IFrame portlets.

Before beginning this exercise, be sure you have downloaded the accessory ZIP file required for the 
exteNd Director tutorials, as described in the section on how to download accessory files.

To import folders and documents into the content repository:

1 Open the accessory archive Director52Tutorial.zip and select Director5_data.zip.

NOTE:  The file Director5_data.zip contains XML descriptors of documents, folders, and other 
content elements, as described in structure of the data import or export archive.
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2 Click Extract and extract the file to a location of your choice.

TIP:   Be sure to remember the location of the file because you will be entering its path in a later step 
in this exercise.

3 On the home page, click the Director CMS link in the Favorites list:

The Content Management tool opens in a separate browser window.
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4 Select the Import Content icon:

The Import Content Management Data panel appears in your browser.

5 In the Data Import Archive field, enter the path to Director5_data.zip and click Import, as in this 
example:
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When the import completes, a summary window displays the following information:

NOTE:  The summary window will not appear if your browser uses a popup blocker. To view the 
summary window (and verify success), disable the popup blocker and reimport the content.

The imported content includes corporate news stories for various departments in a fictitious 
organization, as well as folders and document types. In exteNd Director, a document type is like a 
template that specifies formats and metadata for documents you create.

6 Click Close Import Results.

7 Close the Content Management tool.

Now you are ready to add a content browser to a personal page, using the IFrame portlet. Leave the home 
page open in your browser and move to the next exercise.

Browsing the content repository from a personal page

In this exercise you will create and configure a personal page to allow you to browse the exteNd Director 
content repository through an IFrame portlet.
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Creating a personal page

To create a personal page:

1 On the exteNd Director home page, select Personalize.

The Portal Personalizer opens in your browser.
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2 Under Personal Pages select New.

An untitled page is added to the list of personal pages.

3 Enter the following properties for the new page:

4 Click Update.

The new page appears in the list of personal pages.

Now you are ready to add an IFrame portlet to your personal page and configure it to operate as a content 
browser. Leave the Portal Personalizer running and move to the next exercise.

Adding an IFrame portlet to a page using the Content Selector tool

In this exercise, you will use the Content Selector to add an IFrame portlet to My Content Management 
Page, the personal page you just created. In a later exercise you will learn how to add a portlet to a page 
using the Layout Selector tool (see “Adding an IFrame portlet to a page using the Layout Selector tool” 
on page 118).

To add an IFrame portlet to your personal page using the Content Selector:

1 Select My Content Management Page in the Personal Pages list and click Choose Content.

The Content Selector displays in a new window.

2 From the Filter dropdown list choose Accessory Portlets.

Property What to specify

Page Name My Content Management Page

Description Tutorial
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3 From the Available Content list select IFrame and add it to the page by clicking Add.

The IFrame portlet appears in the Selected Content list.

Now you are ready to configure the IFrame portlet as a content browser. Leave the Content Selector open 
and move to the next exercise.

Configuring the IFrame portlet as a content browser

To configure the IFrame portlet as a content browser:

1 Select the IFrame portlet in the Selected Content list and click Content Preferences.

The Content Preferences sheet opens.

TIP:   To get more information about each preference, click Descriptions at the bottom of the sheet:
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2 Change the values of the following preferences:

NOTE:  xresources is the extended Content Management resource servlet, which provides access 
to folders and documents in the exteNd Director content repository.

3 Click Save Preferences.

The Content Preferences sheet closes, returning you to the Content Selector.

4 Click Save Contents to dismiss the Content Selector.

The Portal Personalizer should still be running.

Now you are ready to test your content browser. Leave the Portal Personalizer running in your browser 
and move to the next exercise.

Preference What to specify

URL http://host name/ExpressPortal/xresources

Width 500
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Testing the IFrame portlet—Browse the content repository

To browse the content repository from your portal page:

1 In the Portal Personalizer, click Portal.

Your home portal page opens in your browser.
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2 Under Personal Pages in the navigation area of the page, click My Content Management Page.

My Content Management Page appears in the content area of your browser, displaying the exteNd 
Director content repository in your content browser portlet window.

The portlet displays the extended view of the content repository, which includes the following 
information about each content element:

Name

Date last modified

File size

MIME type

Whether it has been checked out—and by whom

You will see only those folders and documents you are authorized to view. As a content 
administrator, you can access all content in the repository.
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Your portal page should look something like this:

NOTE:  This image shows only the content you imported into the repository in “Importing folders 
and documents into the content repository” on page 108. You will be able to view and browse any 
other content in your repository as well.

3 Browse the content. Click the names of folders and documents to open them.

For example:

3a Click the Production folder.

3b In the Production folder, click the Sales folder.

3c In the Sales folder, click the New Sales Region document.

The content of the document opens in the browser. Use the Back button of your browser to 
move up a level, or click Up A Level from folder views.

Now you are ready to add document creation capability to your Content Management Page. Leave your 
home page open in your browser and move to the next exercise.

Creating documents from a personal page

In this exercise, you will configure a second IFrame portlet to provide access to the document creation 
utilities of the exteNd Director Content Management system.

Adding an IFrame portlet to a page using the Layout Selector tool

In this exercise, you will use the Layout Selector to add an IFrame portlet to My Content Management 
Page, the personal page that you just created. Recall that in a previous exercise you added a portlet to a 
page using the Content Selector tool (see “Adding an IFrame portlet to a page using the Content Selector 
tool” on page 113).
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To add an IFrame portlet to your personal page using the Layout Selector:

1 On your home page, select Personalize.

The Portal Personalizer opens in your browser.

2 Select My Content Management Page in the Personal Pages list and click Arrange Content.

The Layout Selector opens in a new window:

As you can see, the default layout for personal pages is a two-column layout. The content browser 
portlet that you added in a previous exercise is placed in the first column of the page by default. 
This Layout Selector view allows you to add new portlets to specific locations in your layout and to 
reorganize the page by moving existing portlets to new locations.
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3 In the second column of the page, click Add Content:

A content selector opens in a new window.

4 From the content selector, select an IFrame portlet from the Available Content list, then click Select 
Content.

The content selector closes and an IFrame portlet is added to the second column of the layout view 
of your personal page.
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5 In the tool bar of the IFrame portlet, click the Edit button to modify its properties:

A confirmation window appears, asking if you want to save the layout.

6 Click OK to save the layout.

The Content Preferences sheet opens.

7 Change the values of the following preferences:

NOTE:  This URL gives you access to the document creation utilities of the exteNd Director 
Content Management system.

8 Click Save Preferences to record your changes and return to the Layout Selector.

9 Click Save Layout to return to the Personalizer.

Now you are ready to test the portal page by creating a document and adding it to the content repository. 
Leave the Personalizer running in your browser and move to the next exercise.

Creating a document in the content repository

In this exercise you will use your IFrame portlet to create an HTML document in the exteNd Director 
content repository. Your document will be based on a pre-existing document type called News Article, 
which you imported along with other content in the earlier exercise “Importing folders and documents 
into the content repository” on page 108. 

Preference What to specify

URL http://host 
name/ExpressPortal/portal/pages/PmcTemplates.html

Height 700

Width 800
Using IFrame portlets for content management 121



A document type is like a template, used to define custom fields and styles to associate with a group of 
documents. Custom fields are often used to speed up content queries because they can be searched 
quickly using a database lookup, as opposed to searching document text.

The document type News Article defines a custom field called Department. Using this field, you can 
specify the department that wrote the article. In this example, you will create a short news article for 
Human Resources and store the document in the Production folder for the Human Resources department.

After creating the document, you will publish it and view its content from your content browser portlet.

To create a new document in the content repository from your portal page:

1 In the Portal Personalizer, click Portal.

2 In the navigation area of the page, click My Content Management Page.
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My Content Management Page, appears in the content area of your browser. The page displays the 
content browser on the left and the exteNd Director document creation utility on the right, as 
shown:

You may want to maximize your browser window to see the content of both portlets.

3 In the document creation portlet, select News Article in the Document Types list and click Use.

A create document dialog opens in a new window with the General tab selected.
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4 In the General tab panel, enter the following values in the required fields:

5 Select the Custom Fields tab.

A panel appears showing the custom field Department along with a list of values you can assign to 
the field.

6 Select Human Resources from the list.

7 Select the Content tab.

The Create Content radio button should be selected by default.

8 Click inside the content area and type the following text:
The corporate theatre production for this year will be Romeo and Juliet by 
William Shakespeare.

Your content area should look like this:

9 Click Add and Close in the bottom tool bar 

The document is added to the repository and the Create Content dialog closes.

Now you are ready to publish the document you just created. Leave My Content Management Page open 
in your browser and move to the next exercise.

Required field What to specify

Name Play

Title Corporate Theatre Production

Author adminContent

Folder Follow these steps:

1 Click the ellipsis next to the Folder field.

2 Navigate to Default/Production/Human Resources.

3 Select Human Resources and click Done.
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Publishing your document

To view the content of a document in your content browser portlet, you must first publish the document. 
In this exercise you will learn how to publish a version of your document.

To publish a document:

1 Back in your document creation portlet, click the Content Management icon:

The Content Management tool opens in the IFrame portlet window.

2 In Folder View of the Content Management tool, navigate to and select 
Default/Production/Human Resources.
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Your new file Play should appear in the list of documents in the upper right panel.

3 Select Play, then click Check Out in the Content Property Inspector.

A red check mark appears next to Play to indicate it has been checked out.

NOTE:  Checking out a document locks it, preventing other users from modifying the content. You 
must check out a document before you can publish it.
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4 In the Content Property Inspector, select the Versions tab.

TIP:   You may need to scroll right in the Content Property Inspector to bring the Versions tab into 
view.

5 In the Versions panel of the Content Property Inspector select Version 1, then click Publish.

The Version 1 icon appears with a green border to indicate it has been published.
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Now you are ready to open the new document in your content browser. Leave My Content Management 
Page open in your browser and move to the next exercise.

Opening a document in the content browser portlet

In this exercise, you will navigate to your new document and open it in the content browser. You can view 
published content only.

To open a document in the content browser

1 In the content browser on your personal page, navigate to and select Production/Human 
Resources—the folder in the content repository where you created the new document.

The document Play should appear in the list of documents:

NOTE:  As you can see, the content browser accurately reflects the status of the document Play—
specifically, that it is currently checked out to adminContent. Since you are the user who checked out 
the document, you will be able to open it in the content browser.

2 Click Play in the content browser.
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The content you entered for this document appears in the content browser window:

3 Use the Back button of your browser to move up a level to Production/Human Resources in the 
content repository.

4 Back in the document creation portlet, select the General tab in the Content Property Inspector.

TIP:   You may need to scroll left in the Content Property Inspector to bring the General tab into view.

5 Select Play, then click Check In in the Content Property Inspector.

TIP:   You may need to scroll right in the Content Property Inspector to bring the Check In icon into 
view.

The document is checked in.

6 Refresh the content browser portlet to update the status of the Play document.

TIP:   Right-click in the content browser portlet window and select Refresh.

7 Close the browser.

What to do next
Use the Content Selector to change the name of your second IFrame portlet from IFrame to 
Content Creator. 

TIP:   The instructions for changing the name of a portlet that you add to a page appear in the 
procedure for “Adding an IFrame portlet to a page using the Content Selector tool” on page 113.

Create a container page.

Brand a container page.

Learn how to develop a custom portlet.

Create shortcuts with images from a resource set

Use the Shortcut portlet for form-based authentication
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Creating shortcuts with images from the resource set

Objective
To use scoped paths in the Shortcut portlet for creating dynamic URLs using images from the resource 
set. 

A Shortcut portlet generates a list of shortcut links to Web resources and local applications. 

Scoped paths are constructs that allow you to quickly access persistent and nonpersistent data in exteNd 
Director applications using xPath-like expressions.

A resource set is a location in an exteNd Director project containing application resources that are not 
stored in a database or defined in the configuration and service files. For example, resource sets can store 
portlets, pageflows, styles, images, and Java classes.

Before you begin See “About exteNd Director Tutorials”

Audience This section is for all users, whether or not they have administrative privileges.

Concepts
Working with portal pages

About the Portal Personalizer

Resource sets

Scoped paths

Working with installed portlets

Exercises
Creating a personal page

Adding a Shortcut portlet to your personal page

Configuring a Shortcut portlet to create dynamic URLs with images

Testing the dynamic image URL

Creating a personal page

In this exercise, you will create a new personal page. Later, you will add a Shortcut portlet to this page.

To create a personal page:

1 Start the exteNd Application Server where the Express Portal application has been deployed.

2 Start a browser.
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3 Start the Express Portal application by entering this URL in your browser:

http://host/ExpressPortal

The default page for a guest user opens in your browser.

4 Click Login.
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The Login dialog opens in your browser:

5 Log in as an authorized user, then click login or the Enter key.

TIP:   If you need to create a user, see the exercise on adding a new user.

The default page for the user you specified opens in your browser.
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6 On the default page, select Personalize.

NOTE:  This is the default page for a user who is not an administrator. Your default page will look 
different if you logged in as an administrator, but the Personalize option is still available in a similar 
location on the page.

The Portal Personalizer opens in your browser.
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7 Under Personal Pages select New.

An untitled page is added to the list of personal pages.

8 Enter the following properties for the new page:

9 Click Update.

The new page appears in the list of personal pages.

Now you are ready to add a Shortcut portlet to your personal page. You will configure the portlet to 
display dynamic URLs using an image from the Express Portal project’s resource set. Leave the 
Personalizer running and move to the next exercise.

Adding a Shortcut portlet to your personal page

To add a Shortcut portlet to a personal page:

1 Select My Shortcut Page in the Personal Pages list and click Choose Content.

The Content Selector displays in a new window.

2 From the Filter dropdown list choose Accessory Portlets.

3 From the Available Content list select Shortcut and add it to the page by clicking Add.

Property What to specify

Page Name My Shortcut Page

Description Tutorial
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Your Content Selector window should look like this:

Now you are ready to configure the Shortcut portlet to create dynamic URLs with images. Leave the 
Content Selector open and move to the next exercise.

Configuring a Shortcut portlet to create dynamic URLs with images

In this exercise you will configure the Shortcut portlet to create dynamic URLs with an image from the 
Express Portal project’s resource set. You will use the predefined Resource Set scoped path which 
accesses persistent data stored in your exteNd Director project resource set.
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To create a dynamic URL with an image:

1 In the Content Selector, select the Shortcut portlet in the Selected Content list and click Content 
Preferences.

The Content Preferences sheet opens.

TIP:   To get more information about each preference, click Descriptions at the bottom of the sheet.

2 In the Preference Value column for the shortcut link preference, click the View/Edit Custom 
Preference link.

A second preference sheet opens in your browser containing a set of predefined shortcuts, each 
with its own set of preferences. You can also add new shortcuts.
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3 Display the preferences for the first predefined shortcut—Novell Developer Kit— by clicking the 
plus sign to the left of Details.

The preferences for the Novell Developer Kit shortcut are displayed on the preference sheet.

TIP:   To view descriptions for each preference, scroll to the bottom of the preference sheet and click 
Show Descriptions.

4 In the Image field for the Novell Developer Kit shortcut, enter the following scoped path:
${Portal/Url/Resource/images/novell_n_small.gif}

NOTE:  The syntax for entering a scoped path in a portlet preference is ${scoped path}. In this 
example, the scoped path Portal/Url/Resource/images/novell_n_small.gif accesses a GIF image 
in the Portal application’s resource set. As its name suggests, the image is a small version of the 
Novell logo (red N).
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Your preference sheet should look like this:

5 Close the preferences for the Novell Developer Kit shortcut by clicking the minus sign to the left of 
Details.

6 Repeat Step 3 through Step 5 for the other predefined shortcuts to Novell sites that appear on the 
preference sheet:

6a Novell exteNd Product Information

6b exteNd Documentation

6c Novell Forge

6d Novell on Linux
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7 Scroll to the bottom of the preference sheet and click the Save button.

8 Click Return to List View.

9 Click Save Preferences.

Your changes are recorded and you return to the Content Selector.

10 Click Save Contents to dismiss the Content Selector.

Now you are ready to test the dynamic image URL you just created in your My Shortcuts portlet. Leave 
the Portal Personalizer running and move to the next exercise.
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Testing the dynamic image URL

To test the dynamic image URL:

1 In the Portal Personalizer, click Portal.

Your default portal page opens in the browser.
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2 Select My Shortcut Page under Personal Pages in the navigation list.
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My Shortcut Page appears in the content area of your browser, displaying all the predefined 
shortcuts in the My Shortcuts portlet window. Note that the Novell logo image (red N) appears next 
to each of the predefined Novell shortcuts:

Each logo image is a dynamic link to the associated Web page or application specified in the 
shortcut.
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3 Click the red N next to Novell Forge.
144   exteNd Director Tutorials



4 The Novell Forge Web site opens in a new browser window, as in this example:

TIP:   To learn how to register with Novell Forge and log in using form-based authentication, see the 
tutorial “Using Shortcut portlets for form-based authentication” on page 71.

What to do next
Add an image to the Express Portal project resource set and use it to create a dynamic URL in a 
shortcut.

TIP:   You can add the supplied image new_logo.gif to the resource set, as described in the exercise 
“Adding new branding images to the Express Portal project” on page 47. Then, you can reference that 
image using the following scoped path:

${Portal/Url/Resource/images/new_logo.gif}

Create a content management page using IFrame portlets

Configure portlets for form-based authentication

Learn about shared pages.

Learn about container pages.

Create a container page.

Brand a container page.

Learn how to develop a custom portlet.
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IV Working with Pageflows and Forms

Choose an exercise for a topic you want to learn about:

• Creating a Database Pageflow
• Customizing Pageflow-generated Forms
• Using the Form Designer Wizard
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Creating a Database Pageflow

Objective
To create a database pageflow using the Database Pageflow Wizard. 

The pageflow you create in this exercise accesses two tables that are related by a one-to-many 
(master/detail) relationship. When you build a database pageflow that combines data from tables that 
have a master/detail relationship, the wizard generates multiple pageflow processes, one for each level 
within the query. 

Before creating the pageflow, you first need to create a database that has two tables that have a 
master/detail relationship. In addition, you need to create a connection pool and a database profile.

NOTE:  The Director52Tutorial.zip file includes a SQL file called DBPageFlowTutorial.sql that you can 
use to create the database for this exercise. Details for loading and executing this file are provided below.

Before you begin See “About exteNd Director Tutorials”.

Concepts
About Pageflows and XForms

About the Database Pageflow Wizard

Exercises
To create the database required for this exercise:

To create a connection pool for the database:

To create a database profile:

To create the database pageflow:

To create a personal page that displays the portlet for the pageflow:

To test the pageflow:
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To create the database required for this exercise:

1 Start MySQL monitor in a command window:

2 Create the database for the tutorial by executing the DBPageFlowTutorial.sql script:
source c:\sql\DBPageFlowTutorial.sql

NOTE:  The DBPageFlowTutorial.sql file is included in the Director52Tutorial.zip file. You need to 
extract this file to a location on disk (such as c:\sql) before you execute the script.

To create a connection pool for the database:

1 Start the application server.

TIP:   Click the Start menu and navigate to Novell exteNd 5.2.1>AppServer>Application Server.

2 Start the SMC.

TIP:   Click the Start menu and navigate to Novell exteNd 5.2.1>AppServer>Server Management 
Console.

3 Select the Configuration icon from the toolbar, if it’s not selected already.

4 Click Pools.

5 Choose JDBC and click Add.

6 Select the Pre-configured exteNd Settings radio button, if it’s not selected.

7 Select MySQL as the database platform and use the default settings for this platform.

8 Click Next.

Platform Instructions

Linux Navigate to the MySQL/scripts folder and run the StartMySqlClient.sh script. For 
example, to login with the user root and password novell, you would execute 
this command:

StartMySQLClient root novell

Windows Navigate to the MySQL\bin folder and run the mysql executable. For example, to 
login with the user root and the password novell, you would type this 
command:

mysql -uroot -pnovell
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9 Specify TutorialDB as the pool name and enter the root user ID and password for MySQL.

10 Click Next.

11 Enter this string as the JDBC URL:
jdbc:mysql://localhost:63306/tutorialdb?profileSql=false&maxRows=0

12 Click Next.

13 Click Next on each subsequent panel to accept the default settings. 

14 On the final panel of the connection pool wizard, click Finish.

To create a database profile:

1 Start exteNd Director. 

TIP:   Click the Start menu and navigate to Novell exteNd 5.2.1>Director>Director Designer.

2 Open the Express Portal project if it’s not open already.

3 Select Profiles from the Tools menu.

4 Choose the Databases tab and click New.

5 Specify TutorialDB as the profile name.

6 Select com.mysql.jdbc.Driver as the JDBC driver.

7 Enter this string as the JDBC URL:
jdbc:mysql://localhost:63306/tutorialdb?profileSql=false&maxRows=0
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8 Enter this string as the datasource name:
JDBC/TutorialDB

9 Click Test to be sure your settings are correct.

10 If the test is successful, click OK to save the settings.

11 Click OK to close the Profiles dialog. 

To create the database pageflow:

1 With the Express Portal project open in exteNd Director, select File>New>File.

2 Click the Portlet tab.

3 Select Database Pageflow and click OK:

4 Select TutorialDB as the database profile enter the root user ID and password for MySQL.
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5 Click Next.

6 Select departments as the primary table for your pageflow.

7 Click Next.

The Database Columns dialog displays, showing any tables directly related to the primary table, 
along with columns defined on these tables.
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8 Select departments in the Database Columns box and add all columns for this table:

9 Select employees in the Database Columns box. Add all columns for this table just as you did for 
the departments table.

The Selected Columns list should show all of the columns for both tables in the database:

10 Click Next.

11 Click Next to accept the default settings on the UI Options panel.

12 Click Next to accept the default settings on the Specify Formatting panel.

These settings control the appearance of controls on the Search, View Details, Edit Record, and 
New Record forms.

13 Click Next to accept the default settings on the Column Details panel.

14 Click Next to accept the default settings on the Update Strategy panel.
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15 Type the prefix Tutorial in front of the words departments and employees on the Generated Files 
panel. 

These strings will be used as the base names for the files that will be generated by the wizard. You 
need to specify a separate base name for each database table you select.

16 Click Finish.

To create a personal page that displays the portlet for the pageflow:

1 Start a browser.

2 Open the Express Portal application by typing this URL:

http://host/ExpressPortal

The default page for a guest user opens in your browser.

3 Click Login.
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The Login dialog opens in your browser:

4 Log in as a portal administrator or as a user, then click login or the Enter key.

The default page for the user you specified opens in your browser.

5 Click Personalize.

6 Click New.

7 Type Tutorial as the page name and click Update.

8 Click Choose Content.

9 In the Available Content box, select the TutorialdepartmentsPageflow and click Add.

10 Click Save Contents.

11 Click Portal.
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12 Under Personal Pages, select Tutorial.

The portlet is initiated and the Search Form is displayed.

To test the pageflow:

1 Click the Search button to see a list of all departments in the database.

TIP:   You can also narrow the search by entering one or more characters in either of the fields on 
the Search Form. For example, you might enter Doc to search for the Documentation department. 
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2 Click the View link for the Documentation department:

3 Click the View link for employee John Coltrane.

4 Click the Edit link at the bottom of the form.

5 Change the salary for John Coltrane to 50000.00 and click Update.

6 Click New Record at the bottom of the screen.

7 Specify values for a new employee. When you’re done, click Save.

TIP:   To insert a new employee row, you need to specify a department ID that already exists in the 
database. Valid department IDs are 1 through 9.

What to do next
Learn about customizing the generated forms

Learn about modifying database pageflows

Learn about pageflow activities

Learn about pageflow links
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Customizing Pageflow-generated Forms

Objective
To learn how to use the Form Designer to:

Apply Novell data type formats to form controls

Use the Style Manager to change fonts

Define Model Item Properties on a bind element

Before you begin See “About exteNd Director Tutorials”.

Prerequisites You must complete the exercises in “Creating a Database Pageflow” on page 149.

Concepts
About the Form Designer

About the Form tab

About the Model tab

About the Event Editor

Exercises
“Displaying data with a custom format” on page 160

“Adding class style rules” on page 160

“Adding model item properties” on page 164

Before you get started You’ll be working with forms that you generated when you did the “Creating 
a Database Pageflow” on page 149. You’ll be working with the following forms:

TutorialemployeesDetails.xhtml

TutorialdepartmentsEdit.xhtml

You can open these forms in the Form Designer by:

Navigating to ExpressPortal-resource.spf\data\form directory (make sure you are viewing the 
ExpressPortal.spf file using source layout), then selecting the form and:

Double-clicking it

or 

Right mouse-clicking and choosing Open

or

Opening the form from within the Pageflow (Tutorialemployees.xml and Tutorialdepartments.xml 
).
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Displaying data with a custom format

To specify a data type for a bind element:

1 Open TutorialemployeesDetails.xhtml.

2 Click the Form tab.

3 Select hiredate.

4 Navigate to the Property Inspector (in the lower right pane).

TIP:   Make sure you select the Output tab of the Property Inspector and not the Output (label) tab.

5 Change the Format property as follows:  

6 Select salary.

7 Navigate to the Property Inspector (in the lower right pane) and make the following changes to the 
Format property:  

8 Click Save.

Adding class style rules

To add a class style rule:

1 Open TutorialemployeesDetails.xhtml (located in the ExpressPortal project under ExpressPortal-
resource.spf\data\form).

2 In the Form tab, select the employeeid label.

3 In the Property Inspector select the Output(label) tab.

4 Click Edit class style rules. The Edit class styles dialog displays:

Control name Format property value

hiredate dd/MM/yyyy

Control name Format property value

salary CURRENCY
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5 Click New Style.

The Add new style dialog displays:

(Class name is a generated value, so the value in your dialog might be different.)

6 Accept the default class name and click OK.

The Style Manager dialog displays:
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7 Select the Text tab and supply these values:

8 Click OK to close the Font properties dialog.

9 Click OK to close the Style Manager dialog.

10 Click Save.

You can see the changes on the form when you run it in Preview mode (clicking the XForms Preview tab 
in the Form Designer) or by running the form within the Pageflow.

To test the format and font changes:

1 Start a new application server session.

2 Start a new browser instance.

3 Open the Express Portal application by typing this URL:

http://host/ExpressPortal

The default page for a guest user opens in your browser.

4 Click Login.

Property Value

Font family Arial, Helvetica, sans-serif

Font size 12 pt

Font weight bold
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The Login dialog opens in your browser:

5 Log in as a portal administrator or as a user, then click login or the Enter key.

The default page for the user you specified opens in your browser.

6 Click Tutorial (under Personal Pages).

7 Click Search.

8 Click View to view a list of employee records for a department (for example, Product 
Development).

9 Choose an employee (for example, Duke Ellington) and click View.

You will see the employee record with:

The currency format applied to the salary field and the date format applied to the hire date field.

The employeeid label style changes
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Adding model item properties

To define an instance element as Required

1 Open TutorialemployeesEdit.xhtml.

2 In the Model tab, select the bind:nodeset=record/firstname element.

3 In the Property Inspector, click Add Model Item Properties.

4 In the Add Model Item Properties dialog, select Required, then click OK.

5 In the Property Inspector, change the Required value to true().

6 Click Save.

To test the changes:

1 Restart your application server and browser instances.

2 Click Search.

3 Click View to view any of the employee records.

4 Choose an employee and click Edit.

5 Clear the First Name field and click Update.

The first time you do this, you are notified by a dialog that the data is invalid. When you clear the 
dialog, the field causing the problem is displayed in red. If you click Update again without 
correcting the problem, you’ll see a second dialog indicating a submission error. These message 
actions are created by default when the forms are created. You can modify the messages in the 
Model tab of the Form Designer.
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Using the Form Designer Wizard

Objective
To learn how to use the Form Designer Wizard to:

Create a new form using sample instance data

Reference an external schema file

Apply formats to the instance data

Before you begin See “About exteNd Director Tutorials”.

Concepts
About the Form Designer

About the Form tab

About the Model tab

About the Event Editor

Exercises
To access the schema file needed for this exercise:

To create a form using the Form Designer Wizard:

To test the form:

To reference an external schema:

To apply data type formats:

To access the schema file needed for this exercise:

1 Navigate to the Projects\Express\data directory (under the exteNd installation directory).

2 Create two new subdirectories called xsd and xml.

3 Copy EmployeeList.xsd to the xsd directory and EmployeeListData.xml to the xml directory. 
(Both files are located in the Director52Tutorial.zip file). 

To create a form using the Form Designer Wizard:

1 With the Express Portal project open in exteNd Director, select File>New>File.

2 Click the Portlet tab.

3 Select Form.
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4 Click OK.

5 Enter TutorialEmployeesList as the Form name.

6 Click Next.

7 With the Sample XML data radio button selected, click Browse.

8 Select EmployeeListData.xml and click Next. (You copied this file to the 
Projects\Express\data\xml directory earlier).

9 Click Next to accept the defaults on the controls formatting panel.

10 Click Finish. When the Form Designer Wizard completes, your generated form should contain two 
layout boxes and a repeat look like this:
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To test the form:

1 With the TutorialEmployeesList form open in the Form Designer, click XForms Preview.

Your form should look like this:

You can also use XForms Preview mode to verify the format of the data your form submits by 
clicking the form’s submit button and viewing the results in the left-most pane.

Click View form in browser to see get an idea of what the form looks like within the browser 
environment. You cannot test submissions in the browser environment though.

To reference an external schema:

1 With the form open in the Form Designer, choose the Model tab.

2 Select the Model root node.
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3 In the Property Inspector, click Edit schema list.

4 Click Add.

5 Click EmployeeList.xsd from the ExpressPortal-ResourceSet\xsd directory.

6 Click OK.

7 Click OK.

8 Save the form.

To apply data type formats:

Now that the model is associated with a schema, you can apply data type formats to the bound controls. 

1 With the form open in the Form Designer, choose the Form tab.

2 In the Repeat block, select data:hireDate.

3 In the Property Inspector, change the:

Width property to 173

Format property to FULL
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4 In the Repeat block, select data:salary.

5 In the Property Inspector, change the:

Format property to CURRENCY

6 Click Save.

7 Click XForms Preview to see the changes to the form.
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